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WARNING!

 

Follow the precautions listed below to avoid permanent damage to the emulator.

I. Always use a grounding strap to prevent damage resulting from electrostatic discharge (ESD).

II. Power-Up Precautions.

1. Ensure that all power to the emulator and the target application (if any) is turned OFF.

2. Connect the target pod to the target application (if any).

3. Power up the emulator, then press the RESET button.

4. Power up the target application (if any).

III Power-Down Precautions.

When powering down, follow this procedure in the precise order shown below:

1. Power down the target application board (if any).

2. Remove the target pod.

3. Power down the emulator.

 

NOTES:

 

1. Refer to the ÒPrecaution ListÓ section of the Product Information sheet for additional operating
precautions specific to various devices.

2. Do not leave the emulator powered up with the RS-232C cable connected to a powered-down PC.

3. Before inserting target pod into target application board, refer to Chapter 2 to determine appropriate
jumper selections and options.

Electrical Safeguards
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© 1999 by ZiLOG, Inc. All rights reserved. No part of this document may be copied or reproduced in
any form or by any means without the prior written consent of ZiLOG, Inc. The information in this
document is subject to change without notice. Devices sold by ZiLOG, Inc. are covered by warranty
and patent indemnification provisions appearing in ZiLOG, Inc. Terms and Conditions of Sale only.

ZiLOG, Inc. makes no warranty, express, statutory, implied or by description, regarding the
information set forth herein or regarding the freedom of the described devices from intellectual property
infringement. ZiLOG, Inc. makes no warranty of merchantability or fitness for any purpose.

The software described herein is provided on an as-is basis and without warranty. ZiLOG accepts no
liability for incidental or consequential damages arising from use of the software.

ZiLOG, Inc. shall not be responsible for any errors that may appear in this document. ZiLOG, Inc.
makes no commitment to update or keep current the information contained in this document.

ZiLOG's products are not authorized for use as critical components in life support devices or systems
unless a specific written agreement pertaining to such intended use is executed between the customer
and ZiLOG prior to use. Life support devices or systems are those which are intended for surgical
implantation into the body, or which sustains life whose failure to perform, when properly used in
accordance with instructions for use provided in the labeling, can be reasonably expected to result in
significant injury to the user.

 

ZiLOG

 

, Inc. 
910 East Hamilton Ave., Suite 110
Campbell, CA 95008
Telephone: (408) 558-8500
FAX: (408) 558-8300
Internet:  http://www.zilog.com
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ABOUT THIS MANUAL

 

We recommend that you read and understand everything in this manual before setting up and 
using the product. However, we recognize that users have different styles of learning. There-
fore, we have designed this manual to be used either as a how-to procedural manual or a ref-
erence guide to important data.

The following conventions have been adopted to provide clarity and ease of use:

 

•

 

Universe Medium 10-point all-caps is used to highlight to the following items:

–  commands , displayed messages

– menu selections, pop-up lists, button, fields, or dialog boxes 

– modes

– pins and ports

– program or application name

– instructions, registers, signals and subroutines

– an action performed by the software

– icons

 

•

 

 Courier Regular 10-point is used to highlight the following items

– bit

– software code

– file names and paths

– hexadecimal value

 

•

 

Grouping of Actions Within A Procedure Step

Actions in a procedure step are all performed on the same window or dialog box.
Actions performed on different windows or dialog boxes appear in separate steps.
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CHAPTER 1

INTRODUCTION

OVERVIEW

Congratulations for selecting a fine development tool! The Z9036900ZEM emulator is 
ZiLOG’s in-circuit emulator providing emulation for the Z8930X, Z8933X, Z9034X, 
Z9035X and Z9036X family of TV controllers. The emulator is also capable of OTP pro-
gramming for the family being emulated. The emulator is designed to be used with Zilog 
Developers Studio, giving the user a total package to debug, write and edit your applications.

EMULATOR FEATURES

Key features of the Z9036900ZEM emulator include:

• Supports all existing features of the original Z9035900ZEM and Z8930900ZEM
emulators 

• Provides OTP programming support for the Z9034X, Z9035X and Z9036X products
as well as improved programming of Z893X products

• Editing program memory, DSP RAM, register files 

• Tracking memory locations tracked and setting breakpoints ROM

• Single stepping into codes

• Viewing of multiple windows and the contents of program memory, register files, and
DSP RAM can be edited

• Operating multiple emulators at the same time

• Multitasking other Windows applications while Zilog Developer Studio (ZDS) is
running
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SUPPORTED ZILOG DEVICES

Table 1-1 shows the products supported by the Z9036900ZEM Emulator:

HARDWARE SPECIFICATIONS

OPERATING CONDITIONS

Operating Humidity: 10%-90% RH (Non condensing)

Operating Temperature: 20°C ±10°C

Clocks: The control processor operates at 3.6864 Mhz, the 
emulation processor operates at 32Khz to 12 Mhz

Serial Baud Rate: 57,600 bps

POWER REQUIREMENTS

This emulator requires an external 5VDC power supply.

Operating Voltage (Input): +4.75 VDC to +5.25 VDC Max (+5.0 VDC typical) 

Operating Voltage (Target): +4.75 VDC to +5.25 VDC Max (+5.0 VDC typical) 

Operating Current: 2.5A typical

TABLE 1-1. SUPPORTED PRODUCTS

Packages Emulation OTP Required accessories

40 PDIP Z89300 N/A 40pin Dip Emulation Pod (PC ASSY#99C0395-001)

42 SDIP Z89331/2 Z89331 42pin Dip Emulation Pod (PC ASSY#99C0394-001)
42pin Dip OTP Adapter (PC ASSY#99C0615-001)

42 SDIP Z89361/5 Z89361 42pin Dip OTP Adapter (PC ASSY#99C0615-001)

52 SDIP Z89301/2 N/A 52pin Dip Emulation Pod (PC ASSY#99C0393-001)

52 SDIP Z90341/5/6/7/8 Z89341 52pin Dip Emulation Pod (PC ASSY#99C0393-001)
52pin Dip OTP Adapter (PC ASSY#99C0616-001) 

52 SDIP Z90351/5/6/7/8 Z89351 52pin Dip Emulation Pod (PC ASSY#99C0393-001)
52pin Dip OTP Adapter (PC ASSY#99C0616-001) 
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SERIAL INTERFACE

Zilog Developer Studio communicates with the Z9036900Z Emulator using a DB25, RS-232 
DCE cable (TxD, RxD only).

GUI-SUPPORTED COMPILER, ASSEMBLER FORMATS

The Emulator supports object (binary or Intel hex) code files produced by ZiLOG Developer 
Studio, ZiLOG Macro Cross Assembler (ZMASM).

KIT CONTENTS

The emulator kit contains one of each of the following items:

• Z9036900ZEM Emulator Board

• Z9035912GSE ICE Chip (installed on board)

• Z8930912GSE ICE Chip (installed on board)

• Power Cable with Banana Plugs

• RS-232 Serial Cable, 9-pin M-F

• 60-Pin Target Cable

• 40PDIP Emulation Pod (PC ASSY#99C0395-001)

• 42PDIP Emulation Pod (PC ASSY#99C0394-001)

• 52PDIP Emulation Pod (PC ASSY#99C0393-001)

• 42PDIP OTP Adapter (PC ASSY#99C0615-001)

• 52PDIP OTP Adapter (PC ASSY#99C0616-001)

• CD-ROM containing Zilog Developer Studio

• Z9036900ZEM Users Manual

• 1999 Technical Library CD-ROM

• ZiLOG Developer Studio manual contained on the ZDS installation CD-ROM. 

NOTE: If the ZDS CD-ROM doesn’t contain the manual it can be downloaded from the ZiLOG web 
page at www.zilog.com. 

ADDITIONAL ITEMS NOT SUPPLIED

The following items are required but are not currently supplied in the emulator kit:
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• A source of power (+5VDC typical) for the emulator. This can be a laboratory power
supply with current rating of at least 1.5 ampere.

• Your target design, typically this is a wire-wrapped or printed circuit prototype that
includes a socket for the target device which the emulator cable/pod plugs into.

OPTIONAL RECOMMENDED ITEM

The following items are recommended:

• Oscilloscope

• Logic Analyzer

• C-Compiler 

NOTE: When this manual was released ZDS did not have a C compiler.   Until ZDS’s C compiler is 
completed the user should use Production Languages Corp. (PLC) 3xx IDE tool to compile programs 
in C. Contact ZiLOG customer service to see if the ZDS C compiler has been completed.)

COMPUTER REQUIREMENTS

MINIMUM REQUIREMENTS

IBM PC (or 100-percent compatible) 486-Based Machine

33 MHz

4-MB RAM

VGA Video Adapter

Hard Disk Drive (3.0 MB free space)

3.5-inch, High-Density (HD) Floppy Disk Drive

RS-232 COM Port

Mouse or Pointing Device

Microsoft Windows 3.1

CONTACTING ZILOG CUSTOMER SUPPORT

ZILOG has a worldwide customer support center located in Austin, Texas that is open from 
from 7 a.m. to 7 p.m. Central Time.

The customer support toll-free number for the United States and Canada is 1-877-ZiLOGCS 
(1-877-945-6427. For calls outside of the United States and Canada dial 512-306-4067. The 
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FAX number to the customer support center is 512-306-4072. Customers can also E-mail the 
support center at csupport@zilog.com 

For valuable information about hardware and software development tools go to the. ZiLOG 
home page at http://www.zilog.com. The latest released version of the ZDS can be down-
loaded from this site.
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CHAPTER 2

SET-UP AND INSTALLATION

HARDWARE INSTALLATION

Before installing the hardware, refer to Figure 2-1 for a diagram on connecting the emulator 
to your PC and power supply; Figure 2-4 provides option jumper locations.

QUICK INSTALLATION INSTRUCTIONS

To install the hardware utilizing a 5VDC wall-adaptor power supply, perform the following: 

1. Turn on the power supply and ensure that it is set to + 5.0V and 1.5A.

2. Connect the serial cable to the PC.

3. Connect the emulator to the target board (if performing in circuit emulation)

4. Set up the oscillator and option jumpers.

5. Select the ICE chip that you wish to emulate.

6. Plug a 5.0 VDC, 1.5 Amp Wall Power Adaptor to the power connector on the Z9036900.

7. Power up the Z9036900.
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COMPLETE INSTALLATION INSTRUCTIONS

Follow the below procedures for a complete guide on installing the emulator.

Connect the Power Supply

WARNING!

Always check the supply voltage before plugging in the power cord.

1. If the power supply allows voltage adjustment:

• Turn the power supply on and adjust it to +5V

• Adjust the setting for at least 2.5A, if there is a current-limiting adjustment

2. Turn the supply off.

3. Locate the power cable (red wire, black wire, and banana plugs on the other end). Plug in 
the black banana plug into the black jack on the power supply (labeled COM, GND, or with 
the ground symbol). Plug the red plug into the red jack on the power supply (labeled +, +V 
or +5V).

4. Plug the white connector on the other end of the cable into the matching 4-pin connector 
on the back side of the emulator. (This connection is keyed to ensure against an improper 
connection.)

NOTE: The ZiLOG Power Supply Accessory Kit (ZPS05V00ZAC), which is sold separately, provides 
a fixed-5V Universal Output Power Supply, accepts 110V to 220V AC input, and includes a power 
cable and an in-line jack cable.

Connect the Serial Cable to the PC

Locate the serial cable. Connect the male end to the female connector on the back of the ICE-
BOX, and the female end to either the COM1, COM2, COM3, or COM4 connector of the 
host PC.

NOTE: If connector availability is limited to a 9-pin COM1 through COM4, then use either a different 
cable or a 25-pin to 9-pin converter. (Available at any electronic store for a nominal price.)
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FIGURE 2-1. HOOK-UP DIAGRAM

NOTE: Each emulator is shipped with a 20.480MHz oscillator. For other rates, remove the oscillators 
and install different ones that are within the frequency specifications of the device in use. ZiLOG does 
not guarantee operation with oscillators other than the supplied model.

Connect to the Design

To connect to the target design perform the following steps:

1. Locate the emulation cable for the device.

NOTE: Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the cable into the target device. Ensure that the pin 1 marking (as indicated by the red 
mark on the ribbon cable) matches pin 1 on the target board. 

3. Plug the other end of the cables into Target Pod on top of the emulator. See Figure 2-4 for 
the location of the target pod.

Power 
supply

Connection to 
the COM port

Target board

Emulator
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Connect Logic Analyzer (Optional)

The logic analyzer can either be connected as part of the initial setup, or later as the user con-
tinues working with their design. 

To connect to a logic analyzer perform the following steps:

1. Locate the cable for the logic analyzer.

NOTE: Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the logic analyzer into the a ZiLOG logic analyzer adapter (not included with the 
Z9036900 Emulator kit).

NOTE: The logic analyzer adapter can be ordered from customer service by requesting part number 
98C0289-001.

3. Plug the cable from the ZiLOG logic analyzer adapter into the emulator. Ensure that the pin 
1 marking (as indicated by the red mark on the ribbon cable) matches the pin 1 on the target 
board. See Figure 2-4 for the location of the logic analyzer connector.
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Choosing the IceChip

The Z9036900 emulator comes with two removable ICE chips, the Z9035912GSE and the 
Z8930912GSE. These two chips allow the user to emulate Z8930X, Z8933X, Z9036X, 
Z9034X and the Z9035X families of Zillog micro controller.

WARNING!

Failure to follow the below procedures could result in damage to the emulator.

To configure the Z9036900 emulator for Z8930X, Z8933X, Z8936X family of processors 
perform the following steps.

1. Disconnect all power to the emulator

2. Move the Alternate Ice Chip zif socket locking lever to the upright position and remove the 
Z8930912GSE ICE chip.

3. Locate the emulator zif socket labeled U4 . See Figure 2-4 for the location of the zif 
sockets.

4. Place the Z8930912GSE ICE chip into the U4 zif socket. Ensure that the ICE chip’s pin 1 
matches pin 1 on the U4 zif socket. 

NOTE: A dot in the corner of the processor indicates the chip’s pin 1 location.



Hardware Installation Set-Up and Installation

2–6 UM001900-TVC0699

FIGURE 2-2. ICE CHIP INSTALLATION

5. Close the zif socket locking lever.

FIGURE 2-3. CLOSING THE ICE CHIP LOCKING LEVER

6. Remove the Z9035912GSE ICE chip from the U8 zif socket and place it in the Alternate 
Ice Chip zif socket.
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To configure the Z9036900 emulator for the Z9034X and Z90935X family of processors per-
form the following steps.

1. Disconnect all power to the emulator

2. Move the Alternate Ice Chip zif socket locking lever to the upright position and remove the 
Z9035912GSE ICE chip.

3. Locate the emulator zif socket labeled U8. See Figure 2-4 for the location of the zif sockets.

4. Place the Z9035912GSE ICE chip into the U8 zif socket. When placing ensure that the ICE 
chip’s pin 1 matches pin 1 on the U8 zif socket. 

5. Close the U4 zif socket locking lever.

6. Remove the Z8930912GSE ICE chip from the U4 zif socket and place it in the Alternate 
Ice Chip zif socket.
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Power the Emulator

If anything unusual (such as an unexpected sound or smell) occurs when turning on the 
power supply, quickly turn off the power supply and check your connections. If the power 
supply allows voltage adjustment, adjust it again to +5V. (It may be somewhat lower than 
+5V because of the load of the emulator.) If the power supply has a current meter, ensure that 
the emulator is drawing within the rated current.

After power-up, press the RESET button to reset the ICE chip. (Pressing the RESET button 
avoids bus contention on the I/O lines.) If the ICEBOX emulator is not powering your design 
through the VCC pin, turn on the power supply of the design.

WARNING!

If your design already has a power supply, do not power your design from the emulator VCC pin.

When powering down perform the following procedures:

1. Power down the target application board (if using its own power supply).

2. Power down the emulator.

NOTE: Refer to the complete Electrical Safeguards shown on the first page of this manual.

SOFTWARE INSTALLATION

For more information on installing ZDS refer to the user manual PDFs that are included on 
the install program or download the ZDS literature from the ZiLOG web page at zilog.com.
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EMULATOR OPERATION

The following topics guide the user on how to operate the emulator and configure jumper set-
tings.

RESETTING

Press the RESET button on the emulator to reset the state of the target device and the status 
that was established using ZDS. 

For example, it sets the emulator to %000C.

After reset, wait until the Ready LED is ON before starting ZDS. Refer to the LED Opera-
tion section of this chapter for more details.

WARNING!

Always press the RESET button on the emulator before starting ZDS.

LED OPERATION 

ZiLOG emulators use LEDs to communicate the different hardware states. The following 
table gives a description of the LEDs. The Z9036900 LED’s are located on the right side of 
the emulator.

TABLE 2-1. FRONT LED ASSIGNMENTS

LED Indication Description

READY On
Off

Communicating in Bisync Mode and waiting for command
Communicating in ASCII Mode or executing Bisync command

RUN On
Off

Running user code or self testing when first turned on
Not running user code

OTP On
Off

The Emulator is performing OTP programing

PWR On
Off

Emulator is powered 
Power is off
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JUMPER SETTINGS 

The following table lists jumper setting that the are easily configured by the user. See 
Figure 2-4 for the location of the jumpers.

TABLE 2-2. JUMPER SETTINGS

Jumper Pin Position Description

J1 1or2 In Connect the trace external trigger to pin 1 or 2.

J2 1-2 In Selects EPC2 EPROM

J2 2-3 In Select EPC1441 EPROM (default)

J3 N/A In Emulator supplies power to target board

J3 N/A Out Emulator power is isolated from the target board

J4 1-2 In Target system HSYNC is connected to series schmitt-
trigger

J4 2-3 In Target system HSYNC is connected to the emulation 
processors’ HSYNC

J6 1-2 In The watch dog timer stops at the breakpoint (default)

J6 2-3 In The watch dog timer is controlled by the emulator

J7 1-2 In No internal ROM (default)

J7 2-3 In Internal ROM is selected

J8 1-2 In Program address bus of emulation processor is tri-stated

J8 2-3 In Program address bus is controlled by the emulator 
(default)

J9 1-2 In Select this jumper if the target system or the emulator 
provide positive polarity HSYNC

J9 2-3 In Select this jumper if the target system or the emulator 
provide negative polarity HSYNC

J10 1-2 In Composite AD0 input connected to filter on the emulator 
(install J11)

J10 2-3 In Composite AD0 input connected directly to the emulation 
processor

J15 1-2 In The updated firmware from ZDS is downloaded into the 
default boot sector 

J15 2-3 In The updated firmware from ZDS is downloaded into the 
alternate boot sector
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FIGURE 2-4. Z9036900 EMULATOR EXTERNAL TOP VIEW
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PERFORMING OTP PROGRAMMING

The Z9036900 Emulator is designed for OTP programming. To perform OTP programming 
perform the following steps:

1. Locate the supplied OTP adapter for the micro controller you wish to program. Consult
Table 1-1for the proper OTP adapter.

2. Insert the OTP adapter into the emulator’s OTP Programming socket.

FIGURE 2-5. INSTALLING THE OTP PROGRAMING ADAPTER

3. Place the micro controller into the OTP programing adapter. 

4. If the adapter is equipped with a zif socket, ensure that the zif socket locking lever is in the 
down (closed) position.

5. Perform OTP programing. Consult the ZDS user manual for more information on OTP 
programing.

6. Pull straight up on the micro controller to remove it from the OTP programing adapter. 

NOTE: Be careful not the bend the micro controller’s pins when removing it from the OTP adapter.
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CHAPTER 3

OVERVIEW

EMULATION

The Z9036900 emulator comes with two removable ICE chips, the Z9035912GSE and the 
Z8930912GSE. These two chips allow the user to emulate Z8930X, Z8933X, Z9036X, 
Z9034X and Z9035X families of ZiLOG micro controller. The emulator is also capable of 
OTP programming for the family being emulated. 
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USING ZDS

This emulator is fully comp[atible with ZiLOG Developer Studio (ZDS) software. The fol-
lowing steps briefly describe the procedures necessary to setup and create projects with the 
Z9036900 emulator. A summary of the emulator’s available debug windows is also included 
at the end of this chapter.

For more detailed information on using ZDS, refer to the ZDS User Manual (in PDF format) 
located on the installation CD-ROM, or download the latest information from our web site at 
www.zilog.com.

SELECT THE EMULATOR

To select the emulator and create a new project perform the following steps:

1. Open ZDS by selecting Start>Programs>Zilog Developer Studio 2.00> ZDS 2.00.

2. Choose New Project from the File menu. The New Project dialog box appears. 

NOTE: If the project has already been created select Target from the Project menu, and perform the 
following steps that are applicable for the ZiLOG MCU Database dialog box.

FIGURE 3-1. NEW PROJECT DIALOG BOX

3. Select Family  in the Selection by field.

4. Select Z89C00  from the Master pop-up list.

5. Select a micro controller from the Z8930X, Z8933X , Z9036X, Z9034X or Z9035X family 
in the Project Target pop-up list.

6. Select Z9036900ZEM in the Emulator pop-up list. 
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7. Click on the browse button (...) in the Project Name field. The New Project Browse 
dialog box appears. 

8. Enter the project file name  and select a path in the New Project Browse dialog box.

NOTE: All build output files, such as linker and assembly files will be saved in the same directory as 
the project.  

9. Click Save. The project name appears in the Project Name field in the New Project dialog 
box.

10. Click on Chip Data to view the micro controller specifications. 

NOTE: Fields in the Chip Data page are read-only and can not be modified.

11. Click OK. The new project is saved as the name specified in the New Project Browse 
dialog box.

12. Select Emulator Configuration from the Project menu. The Emulator Configuration 
dialog box appears.

FIGURE 3-2. EMULATOR CONFIGURATION DIALOG BOX

13. Ensure that Emulator is selected in the Module field. 

14. Select the port the emulator is connected to from the Port pop-up list.

15. Select 57600  from the Baud Rate pop-up list.

16. Click OK to close and apply the Emulator Configuration options.

17. Select Save Project from the File menu to save the emulator configuration setting. 
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OPEN A PROJECT AND ADD FILES

A previously created project has the following attributes saved with it:

• Target settings

• Assembler and Linker settings for the specified target

• Source files (including header files)

NOTE: Use the Project Viewer window to view and access the various files in any given project.

To open a previously created project perform the following steps:

1.  Select Open Project from the File menu. The Open Project dialog box appears. 

2. In the Open Project dialog box, select the previously created project. The project appears 
in the Project Viewer window.

FIGURE 3-3. PROJECT VIEWER WINDOW

Add an existing file

To add an existing file to a project perform the following steps:

1. Select Add to Project>Files from the Project menu. The Insert Files into Project dialog
box appears.
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FIGURE 3-4. INSERT FILES INTO PROJECT DIALOG BOX

2. Select the file to add to the project. 

3. Click Open. The file appears in the Project Viewer window.

FIGURE 3-5. PROJECT VIEWER WINDOW WITH FILE

4. Double-click on the file in the Project Viewer window. The file appears in the ZDS main 
Edit window.

NOTE: In some cases, non-editable files, such as .obj files need to be included in a project. 
These files will be displayed in the source file list, but cannot be opened. When the project is built, 
these files are automatically linked.

5. Select Update All Dependencies from the Build menu. The Dependencies folder list 
in the Project Viewer window is updated.
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Add a new file

1. Select Add to Project>New from the Project menu. The Insert New Files Into
Project dialog box appears.

2. Type a file name in the File Name field. 

3. Click Open. The new file name appears in the Project Viewer window with a .asm  
suffix, and a blank Edit window also appears.

NOTE:  Header and Included files do not have to be added. The program will detect those called by 
the source code.
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AVAILABLE DEBUG WINDOWS

The following table list the debug window that are available using ZDS.

TABLE 3-1. DEBUG WINDOWS    

Window Function            Updated values will display in red

Watch • Shows the symbols and the contents of the registers (see the ZDS
user manual for more information)

Registers • Shows the contents of registers 

External Registers • Shows the contents of all external registers

• Edit all write-able registers from this window

Code Memory • Allows the user to monitor, edit, and download a file.ld  or
file.hex  into the Code Memory from generated assembly
source code 

• Tracks a specific address entered in the Code Address edit box

Disassembly • Shows code memory along with the corresponding disassembled
code 

• Allows the user to edit, and download a file.ld or file.hex into the
Code memory   

• Follows the program counter 

• Provides a complete scroll down with this window; however the
scroll up is limited

• Accesses the disassembly of code at the address specified in the
Code Address field 

• The Disassembly window is automatically displayed when
debugging hex code or whenever there is no corresponding
source file available at the address specified by the program
counter

Data Memory Bank 0 • Shows Data in Memory Bank 0 

• Monitor and edit the ICE chips internal RAM data by typing an
address in the Bank Address edit box

Data Memory Bank 1 • Shows Data in Memory Bank 1 

• Monitor and edit the ICE chips internal RAM data by typing an
address in the Bank Address edit box
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APPENDIX A

TROUBLESHOOTING GUIDE

INTRODUCTION

Before contacting a ZiLOG representative or submitting a Problem Report, please follow 
these simple steps. Also, check the Precautions and Limitations sections in the Product Infor-
mation document included with the emulator to eliminate other possible known problems. If 
a hardware failure is suspected, contact the local ZiLOG representative for assistance.

ERROR OPENING SERIAL PORT

If the initial ZiLOG screen is not appearing after selecting the COM port and the screen mes-
sage displays Time-out while reading...

1. Check the RS-232C cable connection and communication port selection in ZDS. See Select
the Emulator on page 3-2 for more information on how to configure the host PC’s port.

2. Reset the emulator and ZDS. 

3. Try connecting another cable.

4. Check if transmit/receive signals need to be swapped.

NOTE: On some DB9 connectors for the COM ports, the transmit/receive signal may be swapped and 
a Null Modem adapter may be required.

5. Ensure that the power supply is connected, is turned on, and power is available.

6. Ensure that the power supply is set at the correct voltage.

7. Check if power supply is supplying the required current (1.0A typical, 1.5A maximum) to 
the emulator .

8. Check the selected port using another application or select another COM port.

9. After resetting the emulator, wait a minimum of 5 seconds before running ZDS.
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COUNTER JUMPS TO UNEXPECTED ADDRESS

If any instruction other than a DI  instruction is used to disable interrupts, the possible causes 
could include:

• The stack overflows into the general register locations

• An extra POP, PUSH, IRET , or RET is encountered (stack unbalanced)

• The program resets repeatedly

– Program counter rolls over from value FFFF to 0000 and proceeds back to the
beginning of program

– Watch-Dog Timer (WDT) is not initialized or refreshed

• An unintialized interrupt vector is being activated (the interrupt vector is not set to the
interrupt handler)

ZDS ERROR MESSAGES

CAN NOT OPEN WINDOWS 

If this message appears while attempting to open a window in ZDS, there may not be enough 
memory within the Microsoft Windows environment to properly run ZDS. Try closing the 
other active applications or exit and re-enter the Microsoft Windows environment.

OUT OF SYNCHRONIZATION WITH THE EMULATOR

This message appears whenever communication between the emulator and the PC is inter-
rupted. When this message occurs check the following:

1. Ensure that the power cable is connected.

2. Ensure that the RS-232C cable is connected.

3. Change the baud rate setting (default is 19200 ). A lower setting usually improves 
communications reliability. 

4. Reestablish communication between ZDS and the emulator (see the ZDS user manual for 
more information on  establishing communication with an emulator).
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ASCII CHARACTER SET

TABLE B-1. ASCII CHARACTER SET  

Graphic Decimal Hexadecimal Comments

0 0 Null

1 1 Start Of Heading

2 2 Start Of Text

3 3 End Of Text

4 4 End Or Transmission

5 5 Enquiry

6 6 Acknowledge

7 7 Bell

8 8 Backspace

9 9 Horizontal Tabulation

10 A Line Feed

11 B Vertical Tabulation

12 C Form Feed

13 D Carriage Return

14 E Shift Out

15 F Shift In
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16 10 Data Link Escape

17 11 Device Control 1

18 12 Device Control 2

19 13 Device Control 3

20 14 Device Control 4

21 15 Negative Acknowledge

22 16 Synchronous Idle

23 17 End Of Block

24 18 Cancel

25 19 End Of Medium

26 1A Substitute

27 1B Escape

28 1C File Separator

29 1D Group Separator

30 1E Record Separator

31 1F Unit Separator

32 20 Space

! 33 21 Exclamation Point

" 34 22 Quotation Mark

# 35 23 Number Sign

$ 36 24 Dollar Sign

% 37 25 Percent Sign

& 38 26 Ampersand

' 39 27 Apostrophe

TABLE B-1. ASCII CHARACTER SET (CONTINUED)

Graphic Decimal Hexadecimal Comments
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( 40 28 Opening (Left) Parenthesis

) 41 29 Closing (Right) Parenthesis

* 42 2A Asterisk

+ 43 2B Plus

, 44 2C Comma

- 45 2D Hyphen (Minus)

. 46 2E Period

/ 47 2F Slant

0 48 30 Zero

1 49 31 One

2 50 32 Two

3 51 33 Three

4 52 34 Four

5 53 35 Five

6 54 36 Six

7 55 37 Seven

8 56 38 Eight

9 57 39 Nine

: 58 3A Colon

; 59 3B Semicolon

< 60 3C Less Than

= 61 3D Equals

> 62 3E Greater Than

? 63 3F Question Mark

TABLE B-1. ASCII CHARACTER SET (CONTINUED)

Graphic Decimal Hexadecimal Comments



 ASCII Character Set

B–4 UM001900-TVC0699

@ 64 40 Commercial At

A 65 41 Uppercase A

B 66 42 Uppercase B

C 67 43 Uppercase C

D 68 44 Uppercase D

E 69 45 Uppercase E

F 70 46 Uppercase F

G 71 47 Uppercase G

H 72 48 Uppercase H

I 73 49 Uppercase I

J 74 4A Uppercase J

K 75 4B Uppercase K

L 76 4C Uppercase L

M 77 4D Uppercase M

N 78 4E Uppercase N

0 79 4F Uppercase 0

P 80 50 Uppercase P

Q 81 51 Uppercase Q

R 82 52 Uppercase R

S 83 53 Uppercase S

T 84 54 Uppercase T

U 85 55 Uppercase U

V 86 56 Uppercase V

W 87 57 Uppercase W

TABLE B-1. ASCII CHARACTER SET (CONTINUED)

Graphic Decimal Hexadecimal Comments
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X 88 58 Uppercase X

Y 89 59 Uppercase Y

Z 90 5A Uppercase Z

[ 91 5B Opening (Left) Bracket

\ 92 5C Reverse Slant

] 93 5D Closing (Right) Bracket

^ 94 5E Circumßex

_ 95 SF Underscore

` 96 60 Grave Accent

a 97 61 Lowercase A

b 98 62 Lowercase B

c 99 63 Lowercase C

d 100 64 Lowercase D

e 101 65 Lowercase E

f 102 66 Lowercase F

g 103 67 Lowercase G

h 104 68 Lowercase H

i 105 69 Lowercase I

j 106 6A Lowercase J

k 107 6B Lowercase K

1 108 6C Lowercase L

m 109 6D Lowercase M

n 110 6E Lowercase N

o 111 6F Lowercase O

TABLE B-1. ASCII CHARACTER SET (CONTINUED)

Graphic Decimal Hexadecimal Comments
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p 112 70 Lowercase P

q 113 71 Lowercase Q

r 114 72 Lowercase R

s 115 73 Lowercase S

t 116 74 Lowercase T

u 117 75 Lowercase U

v 118 76 Lowercase V

w 119 77 Lowercase W

x 120 78 Lowercase X

y 121 79 Lowercase Y

z 122 7A Lowercase Z

{ 123 7B Opening (Left) Brace

| 124 7C Vertical Line

} 125 7D Closing (Right) Brace

~ 126 7E Tilde

127 7F Delete

TABLE B-1. ASCII CHARACTER SET (CONTINUED)

Graphic Decimal Hexadecimal Comments
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PROBLEM/SUGGESTION REPORT FORM

If you experience any problems while operating this product, or if you note any inaccuracies 
while reading the User's Manual, please copy this form, fill it out, then mail or fax it to 
ZiLOG. We also welcome your suggestions!

Customer Information

Product InformationReturn Information

Problem Description or Suggestion

Provide a complete description of the problem or your suggestion. If you are reporting a 
specific problem, include all steps leading up to the occurrence of the problem. Attach 
additional pages as necessary.
______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

Name Country

Company Telephone

Address Fax Number

City/State/ZIP E-Mail Address

Serial # or Board Fab #/Rev. # ZiLOG , Inc.

Software Version System Test/Customer Support

Manual Number 910 E. Hamilton Ave., Suite 110, MS 4-
3

Host Computer Description/Type Campbell, CA 95008

Fax Number: (408) 558-8536

Email: tools@zilog.com
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ABS Absolute Value

Address Space Physical or logical area of the target systemÕs
Memory Map. The memory map could be physically
partitioned into ROM to store code, and RAM for data.
The memory can also be divided logically to form sepa-
rate areas for code and data storage.

ANSI American National Standards Institute.

ASAP As Soon As Possible.

ASCII American Standard Code of Information Interchange.

ASM Assembler File.

ASYNC Asynchronous Communication Protocol.

ATM Asynchronous Transfer Mode.

B Binary.

Baud Unit of measure of transmission capacity. 

Binary Number system based on 2. A binary digit is a bit.
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BISYNC Bidirectional Synchronous Communication Protocol.

Bisynchronous A protocol for communications data transfer used
Communications extensive in mainframe computer networks. The

sending and receiving computers synchronize their
clocks before data transfer may begin.

Bit A digit of a binary system. It has only two possible 
values: 0 or 1.

BPS Bits Per Second. Number of binary digits transmitted
every second during a data-transfer procedure.

Buffer Storage Area in Memory. 

Bug A defect or unexpected characteristic or event.

Bus In Electronics, a parallel interconnection of the internal
units of a system that enables data transfer and
control Information.

Byte A collection of four sequential bits of memory. Two
sequential bytes (8 bits) comprise one word.

CALL This command invokes a subroutine

Checksum A field of one or more bytes appended to a block of n
words which contains a truncated binary sum formed
from the contents of that block. The sum is used to
verify the integrity of data in a ROM or on a tape.

COM Device name used to designate a communication
port.
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Control Section A continuous logical area containing code or user 
data. Each control section has a name. The linker puts
all those control sections with the same name in one
entity. The linker provides address spaces to the
control sections. There are either absolute control
sections or relocatable ones.

CPU Central Processing Unit.

Cross-Linkage Editor A linkage editor that executes on a processor that is not
the same as the target processor.

DI Disable Interrupt.

DIP Dual In-line Package. The plastic housing designed to
be attached directly to a circuit board or equipment
case.

DSP Digital Signal Processing. A specialized micropro-
cessor that is tailored to perform high repetition math 
processing and improve signal quality.

EPROM Erasable Programmable Read-Only Memory.

EEPROM Electrically Erasable Programmable Read-Only
Memory.

EI Enable Interrupt.

Emulation Process of duplicating the behavior of one product or 
part using another medium. 

Emulator An emulation device. For example, an In-Circuit 
Emulator (ICE) module duplicates the behavior of the 
chip it emulates in the circuit being tested.

External Symbol A symbol that is referenced in the current program file
but is defined in another program file.
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GUI Graphical User Interface. The windows and text that a 
user sees on their computer screen when they are 
using a program.

H Hexadecimal, Half-Carry Flag.

Hex Hexadecimal.

Hexadecimal A Base-16 Number System. Hex values are often
substituted for harder to read binary numbers.

IC Integrated Circuit.

ICE In-Circuit Emulator. A ZiLOG product which supports
the application design process.

Icon A small screen image representing a specific 
element like a document, embedded and linked
objects, or a collection of programs gathered
together in a group.

ID Identifier.

IE Interrupt Enable.

IM Immediate Data Addressing Mode.

IMASK Interrupt Mask Register.

IMR Interrupt Mask Register.

INC Increment.

INCW Increment Word.

Initialize To establish start-up parameters, typically involving 
clearing all of some part of the deviceÕs memory space.
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Instruction Command.

INT Interrupt.

Internal Symbol A symbol that is defined in a program file. This symbol
could be visible to multiple functions within the same
program file.

I/O Input/Output. In computers, the part of the system that
deals with interfacing to external devices for input or
output, such as keyboards or printers.

IPR Interrupt Priority Register.

Ir Indirect Working-Register Pair Only.

IR Infrared. A light frequency range just below that of
visible light.

IRQ Interrupt Request.

ISDN Integrated Services Digital Network.

ISO International Standards Organization.

JP Jump.

JR Jump Range.

Library A File Created by a Librarian. This file contains a
collection of object modules that were created by an
assembler or directly by a C compiler.

Local Symbol Symbol visible only to a particular function within a 
program file.

Lock Limits Limits set in a financial program that cannot be 
surpassed.
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LSB Least Significant Bit.

LSI Large Scale Integration. A chip that contains 500 to 
5,000 gates or transistors.

M1 Machine Cycle 1.

MCU Microcontroller or Microcomputer Unit. 

MI Minus.

MLD Multiply and Load.

MPYA Multiply and ADD.

MPYS Multiply and Subtract.

MSB Most Significant Bit.

Nibble A Group of 4 Bits.

NMI Non-Maskable Interrupt.

NOP No Operation.

Object Module Programming code created by assembling a file with
an assembler or compiling a file with a compiler.
These are relocatable object modules and are input to
the linker in order to produce an executable file.

OMF Object Module Format.

OPC Operation Code.

Op Code Operation Code.

OTP One-Time Programmable.
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PC Personal computer, program counter.

PCON Port configuration register.

PER Peripheral. A device which supports the import or
output of information.

POP Retrieve a Value from the Stack.

POR Power-On Reset.

Port The point at which a communications circuit termi-
nates at a Network, Serial, or Parallel Interface card.

PRE Prescaler.

PROM Programmable Read-Only Memory.

Protocol Formal set of communications procedures governing
the format and control between two communications 
devices. A protocol determines the type of error 
checking to be used, the data compression method, if 
any, how the sending device will indicate that it has 
finished sending a message, and how the receiving 
device will indicate that it has received a message. 

PRT Programmable Reload Timer or Print.

PTR Pointer.

PTT Post, Telephone, and Telegraph. Agency in many 
countries that is responsible for providing telecommu-
nication approvals. 

Public/Global Symbol A programming variable that is available to more than
one program file.

PUSH Store a Value In the Stack.
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r Working Register Address.

R Register or Working-Register Address, Rising Edge.

RA Relative Address.

RAM Random-Access Memory. A memory that can be 
written to or read at random. The device is usually 
volatile, which means the data is lost without power.

RC Resistance/Capacitance.

RD Read.

RES Reset.

Resolution In a digital image, the total number of pixels in the 
horizontal and vertical directions.

RFSH Refresh.

ROM Read-Only Memory. Nonvolatile memory that stores
permanent programs. ROM usually consists of 
solid-state chips.

ROMCS ROM Chip Select.

RP Register Pointer.

RR Read Register or Rotate Right.

RS-232C Electronic Industries Association Standard for 
Asynchronous Transmissions Between a Computer
and a Peripheral Device.

SCF Set C Flag.
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Schedule Financial Schedule. Computes the costs and profits for 
each significant product line item (by PSI) for a given 
period, usually a fiscal month.

SIO Serial Input/Output.

SL Shift Left or Special Lot.

SLL Shift Left Logical.

SMR Stop Mode Recovery.

SN Serial Number.

SOIC Small Outline IC.

SP Stack Pointer.

SPH Stack Pointer High.

SPI Serial Peripheral Interface.

SPL Stack Pointer Low.

SRAM Static Random Access Memory.

SR Shift Right.

SRA Shift Right Arithmetic.

SRC Source.

SSI Small Scale Integration. Chip that contains 5 to 50 
gates or transistors.

Static Characteristic of Random Access Memory that 
enables It to operate without clocking signals.
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ST Status.

STKPTR Stack Pointer.

SUB Subtract.

SVGA Super Video Graphics Adapter.

S/W Software.

SWI Software Interrupt.

Symbol Definition Symbol defined when the symbol name is associ-
ated with a certain amount of memory space,
depending on the type of the symbol and the size of 
Its dimension.

Symbol Reference Symbol referenced within a program flow, when-
ever It is accessed for a read, write, or execute 
operation.

SYNC Synchronous Communication Protocol. An event or 
device is synchronized with the CPU or other process 
timing.

TC Time Constant.

TCC Total Cash Compensation, Total Corporate Compli-
ance. Total cash compensation includes base salary 
plus all other applicable compensation, including shift 
differential and car allowance.

TCM Trellis Coded Modulation.

TCR Timer Control Register.

TMR Timer Mode Register.
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UART Universal Asynchronous Receiver Transmitter.
Component or functional block that handles asynchro-
nous communications. Converts the data from the 
parallel format in which it is stored, to the serial format 
for transmission.

UGE Unsigned Greater Than or Equal.

UGT Unsigned Greater Than.

ULE Unsigned Less Than or Equal.

ULT Unsigned Less Than.

UM UserÕs Manual.

USART Universal Synchronous/Asynchronous
Receiver/Transmitter. Can handle synchronous as well 
as asynchronous transmissions.

USB Universal Serial Bus.

USC Universal Serial Controller.

UTB Use Test Box. A board or system to test a particular 
chip in an end-use application.

V Volt, Overflow Flag.

VCC Supply Voltage.

VDD Voltage from the Digital Power Supply.

VPP Programmed Voltage.

VRAM Video Random-Access Memory. A special form of
RAM chip that has a separate serial-output port for 
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display refresh operations. This architecture speeds up
video adaptor performance.

VREF Analog Reference Voltage.

WDT Watch-Dog Timer. A timer that, when enabled under
normal operating conditions, must be reset within the
time period set within the application (WDTMR (1,0)). If
the timer is not reset, a Power-on Reset occurs. Some 
older manuals refer to this timer as the WDTMR.

WDTOUT Watch-Dog Timer Output.

Word Amount of data a processor can hold in its registers 
and process at one time. A DSP word is often 16 bits. 
Given the same clock rate, a 16-bit controller 
processes four bytes in the same time it takes an 8-bit 
controller to process two.

WR Write.

WS Wafer Sort.

X Indexed Address, Undefined.

XOR Bitwise Exclusive OR.

XTAL Crystal.

Z Zero, Zero Flag.

Z8 ZiLOG Chip.

ZAC ZiLOG Accessory Kit.

ZASM ZiLOG Assembler. ZiLOGÕs program development
environment for DOS.
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ZDS ZiLOG Developer Studio. ZiLOGÕs program develop-
ment environment for Windows 95/NT.

ZEM ZiLOG Emulator.

ZiLOG Symbol Format Three fields per symbol including a string containing 
the Symbol Name, a Symbol Attribute, and an Absolute 
Value in Hexadecimal.

ZLD ZiLOG Linkage Editor. Cross linkage editor for ZiLOGÕs
microcontrollers.

ZLIB ZiLOG Librarian. Librarian for creating library files from
locatable object modules for the ZiLOG family of
microcontrollers.

ZMASM ZiLOG Macro Cross Assembler. ZiLOGÕs program
development environment for Windows 3.1.

ZOMF ZiLOGÕs Object Module Format. The object module
format used by the linkage editor.
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ICE NEW

ICE_BLOCK

A[0..19]

32KHZ

DSP_CLKnDSP_ADR

DSP_SS

H_SYNC

PA[0..19]

DSP_RW

PD[0..15]

DSP_CLK1

nRESET2
nM_P25

nRESET3

nDSP_RUN
NO_INT1

6D00
6D01

MD[0..7]

DSP_RD

POLARITY
nXOE

XRW

U7_DIR
U7_NOE
XOE_MEM
XRW_MEM
nOE_BRP1

nWE_BRP1

BRP_ROM
TR_OP1
TR_OP0

BOI

MEMORY

MEMORY_BLOCK

nWE_RAM
nOE_RAM

nOE_BRP
nWE_BRP

PD[0..15]

BRP_ROM

A[0..19]

nDSP_ADR

PA[0..19]

nOE_TRAM
nWE_TRAM

TR_OP0
TR_OP1

D_TRACE

TA[0..15] TD[0..20]

BOI

CONT

SYSTEM_CONTROLLER

nM_AS
nM_DS

M_P25

M_RW

MD[0..7]

MA[8..15]nROM_MON
nOE_MRAM
nWE_MRAM
nRAM_MON

nRESET2

nCS_USB
ALE
TR_INT

nIRESET

Z90369_GLUE

CPLD_BLOCK

PA[0..16]

PD[0..15]

6D00
6D01

6D02
6D3X
6D7X

nWE_MRAM
nOE_MRAM

nRAM_MON

nROM_MON

nOE_BRP
nOTPC_EN

nWE_BRP
nOE_RAM
nWE_RAM

nDSP_ADR

NO_INT1
nDSP_RUN

DSP_SS

DSP_RD
32KHZ

DSP_CLK1

BRP_ROM

nM_AS
nM_DS
M_RW

nRESET3

nRESET2

MA[8..15]

H_SYNC
POLARITY

DSP_CLK

MD[0..7]

nCS_USB
ALE

TR_INT

D_TRACE
nOE_TRAM
nWE_TRAM

TR_OP0
TR_OP1
BOI

DSP_RW

TD[0..20]

TA[0..15]
nXOE

U7_DIR
U7_NOE

XOE_MEM
XRW_MEM
nOE_BRP1
nWE_BRP1

XRW

OTP

OTP_BLOCK

6D02

nOTPC_EN

MD[0..7]

PA[0..16]

PD[0..15]

6D7X
6D3X

BRP_ROM

nOE_RAM

nOE_BR

nROM_MON

TA[0..15]

ALE

BOI

TD[0..20]TA[0..15]

nM_AS

MA[8..15]

nWE_RAM

nCS_USB

TR_INT

TR_OP1

NWE_MRAM

TR_OP0

M_RW

nOE_TRAM

nWE_BRP

D_TRACE

nWE_RAM

nWE_TRAM

nOE_BR
nWE_BRP
nOE_RAM

nM_DS

TD[0..20]

nRAM_MON

nOE_MRAM

6D3X

nOTPC_EN

6D02

6D7X

U7_DIR
U7_NOE
XOE_MEM
XRW_MEM
nOE_BRP1
nWE_BRP1

XRW

nDSP_RUN

nRESET2

DSP_CLK

32KHZ

PA[0..19]PA[0..19]

PD[0..15]

DSP_RD

XRW_MEM

PA[0..19]

nDSP_ADR

nWE_BRP1

PD[0..15]

H_SYNC

nXOE

U7_NOE

MD[0..7]

A[0..19]

PD[0..15]PD[0..15]

PA[0..19]

nRESET3

PA[0..19]

DSP_RW

NO_INT1

XRW

nOE_BRP1

6D01

POLARITY

M_P25

MD[0..7]

DSP_SS

MD[0..7]

MD[0..7]

DSP_CLK1

6D00

U7_DIR

A[0..19]

XOE_MEM

BRP_ROM
TR_OP1
TR_OP0
BOI
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5V

GND
GND

VCC

VCC

VCC_14V

CU36

0.1uF

CU47

0.1uF

CU50

0.1uF

CU49

0.1uF

CU48

0.1uF

CU35

0.1uF

CU33

0.1uF

CU32

0.1uF

CU31

0.1uF

CU29

0.1uF

CU28

0.1uF

CU34

0.1uF

CU54

0.1uF

CU53

0.1uF

CU52

0.1uF

CU51

0.1uF

CU46

0.1uF

CU27

0.1uF

CU44

0.1uF

CU45

0.1uF

C12
100uF

R53
330

D4
LED RED

CU30

0.1uF

+ C17
100uF

C18
10uF

C11
100uF

P7
1
2
3
4

U28

DSP1N5S14

1

2 3

4+IN

-IN -OUT

+OUT

U27

DSP1N5S14

1

2 3

4+IN

-IN -OUT

+OUT

U26

DSP1N5S14

1

2 3

4+IN

-IN -OUT

+OUT

F1

RXE160

CU38

0.1uF

CU42

0.1uF

J12

2.4 MM BARREL

CU43

0.1uF

CU37

0.1uF

CU40

0.1uF

CU41

0.1uF

CU39

0.1uF
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OTPD0

GND

OTPD10

TEST_CLK

nWE
TST_SEL1
PGMHB

OTPD7

OTPD14

OTPD3
OTPD1

TST_SEL0

OTPD1

OTPD7
OTPD4

OTPD13

OTPD6

OTPD0OTPD2

PROTECT

OTPD5
OTPD4

OTPD9

OTPD8

OTPD14
OTPD15

OTPD12

PGMLB

nOE

OTPD11
OTPD8

GND

OTPD2

OTPD9

OTPD10

OTPD3

OTPD15

OTPD5

OTPD11

OTPD13

OTPD12

OTPD6

OTPA3

OTPA9

OTPA7

OTPA13

OTPA8
OTPA7

OTPA12

OTPA1

OTPA1

OTPA4

OTPA0

OTPA8

OTPA4

OTPA14

OTPA0

OTPA15

OTPA11

VCC

P_VPP

P_VCC

OTPA9

OTPA2

OTPA10

OTPA12

OTPA3

TST_MODE

OTPA5
OTPA6

OTPA5

OTPA11

OTPA14

OTPA10

OTPA6

EPM

VCC

OTPA15

OTPA13

OTPA2

OTPA[0..16]

PD13
PD14

PD1

PD10

PD0

PD3

PD7

PD15

PD5

PD2

PD8

PD11

PD6

PD4

PD9

PD12

DAC_SEL1

M_D3

M_D0

M_D0

MD4

M_D6

M_D1

M_D7

P_VPP

MD5

DAC2

nOTP_DIR

nOTP_DIR

M_D4

M_D1

M_D4

DAC_SEL0

DAC_SEL1
M_D6

M_D2 DAC1

MD6

M_D2

DAC0

EPM

M_D[0..7]

M_D5

MD1

nOTPA_EN

nLED1

M_D4
M_D3

VCC

M_D2

MD7

M_D5

nLED3

M_D7

M_D3

MD2

DAC3
P_VCC

nOTPD_EN

MD0

M_D5

M_D7

MD3

nOTPD_EN

nLED2

M_D6

TST_MODE

M_D1
M_D0

PA3

PA14
PA15

PA9

PA4

PA7
PA6
PA5

PA8

PA0
PA1
PA2

PA11
PA10

PA12
PA13

nOTPA_EN

OTPD[0..15]

M_D3

PGMLB
M_D6
M_D7

M_D2

M_D0

TST_SEL0

PGMHB

M_D4

TEST_CLK
M_D1 nOE

TST_SEL1

nWE

PROTECT

M_D5

DAC_SEL0

OTPA16

OTPA16PA16

GND

VCC_14V

VCC_14V

VCC

VCC_14V

VCC_14V

VCC

D2

LED

R48

330

R52

330

D3

LED

U20

74F244

2
4
6
8

11
13
15
17

1
19

18
16
14
12
9
7
5
3

1A1
1A2
1A3
1A4
2A1
2A2
2A3
2A4

1OE
2OE

1Y1
1Y2
1Y3
1Y4
2Y1
2Y2
2Y3
2Y4

R37

2K_1%
+

-

U21B

LM324

5

6
7

4
11

Q2
2N2222A

2
3

1

R38

2K_1% R40

2K_1%

C14

0.1uF

R39

10K_1%

R46

330

D1

LED

U23

74FCT162245

47
46
44
43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

48
1

25
24

1A1
1A2
1A3
1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

1OE
1DIR
2OE
2DIR

Q1
2N2222A

2
3

1

C13

0.1uF

R36

2K_1%

R34

2K_1%

R35

10K_1%

R33

2K_1%

C15

0.1uF

R45

2K_1%

R41

2K_1% Q3
2N2222A

2
3

1

+

-

U21C

LM324

10

9
8

4
11

R44

10K_1%

R43

2K_1%

U19

IDT74FCT162827AT

55
54
52
51
49
48
47
45
44
43
42
41
40
38
37
36
34
33
31
30

2
3
5
6
8
9
10
12
13
14
15
16
17
19
20
21
23
24
26
27

1
56
28
29

1A1
1A2
1A3
1A4
1A5
1A6
1A7
1A8
1A9
1A10
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8
2A9
2A10

1Y1
1Y2
1Y3
1Y4
1Y5
1Y6
1Y7
1Y8
1Y9

1Y10
2Y1
2Y2
2Y3
2Y4
2Y5
2Y6
2Y7
2Y8
2Y9

2Y10

1OE1
1OE2
2OE1
2OE2

P5
1
3
5
7
9

11
13
15
17
19
21
23
25
27
29

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30

P6
1
3
5
7
9

11
13
15
17
19
21
23
25
27
29

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30

U25

74FCT162374ATPV

47
46
44
43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

48
1

25
24

1D1
1D2
1D3
1D4
1D5
1D6
1D7
1D8
2D1
2D2
2D3
2D4
2D5
2D6
2D7
2D8

1O1
1O2
1O3
1O4
1O5
1O6
1O7
1O8
2O1
2O2
2O3
2O4
2O5
2O6
2O7
2O8

1CLK
1OE
2CLK
2OE

+

-

U21A

LM324

3

2
1

4
11

U22

MAX506

14
13
12
11
10
9
8
7

17
16

15

2

1

20

19

18
3
6
5
4

D0
D1
D2
D3
D4
D5
D6
D7

A0
A1

WR

VOUTA

VOUTB

VOUTC

VOUTD

VDD
VSS

DGND
AGND
VREF

R42

2K_1%

NC

U24

LM4040-2.5

1

2

3

C16

0.1uF

R51

2K_1%

Q4
2N2222A

2
3

1

R49

2K_1%

R47

2K_1%

R50

10K_1%

+

-

U21D

LM324

12

13
14

4
11

PA[0..16]

PD[0..15]

6D3X

6D7X

MD[0..7]

6D02
nOTPC_EN
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PD0
PD1
PD2
PD3
PD4
PD5
PD6

A2
A3
A4

A8

A1

A13
A12

A10
A9

A6
A5

A11

A0

A14

PD7

PD8
PD9
PD10
PD11
PD12
PD13
PD14
PD15

nOE_RAM
nWE_RAM

A7

A18

A15
A16
A17

A19

PA17
PA18
PA19

PA12

PA5

PA3

PA8

PA2

PA1

PA6

PA15

PA9

PA15

PA3

PA18

PA12

PA14

PA5

PA10

PA17

PA11

PA1

PA6

PA9

PA9

PA0

PA2

PA6

PA3

PA7

PA1

PA13

PA12

PA16
PA15

PA8

PA14

PA14

PA3
PA2

PA0

PA10

PA7

PA6

PA9

PA1

PA7

PA5

PA3

PA14
PA13

PA10
PA9

PA5

PA10

PA16
PA15

PA6
PA5

PA4

PA2

PA13
PA14

PA11

PA11

PA0PA0

PA2

PA16

PA12

PA7

PA7

PA13

PA12

PA11

PA4

PA4

PA8

PA1

PA16

PA16

PA11
PA10

PA4

PA19

PA8

PA13

PA0

PA15

PA8

PA4

TD0

TA2

TA5

TA3

TA11

TA14

TA10

TA4

TA1
TA0

TA12

TA7

TA15

TA8

TA13

TA9

TA6

TA2

TA5

TA3

TA11

TA14

TA10

TA4

TA1
TA0

TA12

TA7

TA15

TA8

TA13

TA9

TA6

TD3

TD0

TD13

TD17
TD16

TD16

TD14

TD14

TD11

TD13

TD19

TD2

TD9

TD19

TD10

TD12

TD6
TD7

TD11

TD8

TD15

TD4

TD4

TD6

TD1

TD3

TD10

TD18
TD17

TD5

TD1
TD2

TD5

TD7
TD8
TD9

TD12

TD15

TD18

TD20

TD20BOI

VCC

VCC

R25A 100K
1 2

R26 100K

R32

10K

R25I 100K
1 10R25H 100K
1 9R25G 100K
1 8

R25E 100K
1 6R25F 100K
1 7

R25B 100K
1 3R25C 100K
1 4R25D 100K
1 5U14

IDT74FCT162827AT

55
54
52
51
49
48
47
45
44
43
42
41
40
38
37
36
34
33
31
30

2
3
5
6
8
9
10
12
13
14
15
16
17
19
20
21
23
24
26
27

1
56
28
29

1A1
1A2
1A3
1A4
1A5
1A6
1A7
1A8
1A9
1A10
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8
2A9
2A10

1Y1
1Y2
1Y3
1Y4
1Y5
1Y6
1Y7
1Y8
1Y9

1Y10
2Y1
2Y2
2Y3
2Y4
2Y5
2Y6
2Y7
2Y8
2Y9

2Y10

1OE1
1OE2
2OE1
2OE2

R29

10K

R30

10K

U12

IDT71124S15PH

1
2
3
4

13
14
15
16
17
18
19
20
21
29
30
31
32

6
7
10
11
22
23
26
27

5
28
12

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9
A10
A11
A12
A13
A14
A15
A16

I/O0
I/O1
I/O2
I/O3
I/O4
I/O5
I/O6
I/O7

CE
OE
WE

U15

IDT71124S15PH

1
2
3
4

13
14
15
16
17
18
19
20
21
29
30
31
32

6
7
10
11
22
23
26
27

5
28
12

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9
A10
A11
A12
A13
A14
A15
A16

I/O0
I/O1
I/O2
I/O3
I/O4
I/O5
I/O6
I/O7

CE
OE
WE

U16

IDT71016S15PH

5
4
3
2
1
44
43
42
27
26
25
24
21
20
19
18

6
41
17
40
39

7
8
9

10
13
14
15
16
29
30
31
32
35
36
37
38

22
23
28

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9

A10
A11
A12
A13
A14
A15

CS
OE
WE

BHE
BLE

D0
D1
D2
D3
D4
D5
D6
D7
D8
D9
D10
D11
D12
D13
D14
D15

NC1
NC2
NC3

R28

10K

U13

IDT71016S15PH

5
4
3
2
1
44
43
42
27
26
25
24
21
20
19
18

6
41
17
40
39

7
8
9

10
13
14
15
16
29
30
31
32
35
36
37
38

22
23
28

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9

A10
A11
A12
A13
A14
A15

CS
OE
WE

BHE
BLE

D0
D1
D2
D3
D4
D5
D6
D7
D8
D9
D10
D11
D12
D13
D14
D15

NC1
NC2
NC3

U18

74F244

2
4
6
8

11
13
15
17

1
19

18
16
14
12
9
7
5
3

1A1
1A2
1A3
1A4
2A1
2A2
2A3
2A4

1OE
2OE

1Y1
1Y2
1Y3
1Y4
2Y1
2Y2
2Y3
2Y4

U11

IDT71124S15PH

1
2
3
4
13
14
15
16
17
18
19
20
21
29
30
31
32

6
7

10
11
22
23
26
27

5
28
12

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9

A10
A11
A12
A13
A14
A15
A16

I/O0
I/O1
I/O2
I/O3
I/O4
I/O5
I/O6
I/O7

CE
OE
WE

U17

IDT74FCT162827AT

55
54
52
51
49
48
47
45
44
43
42
41
40
38
37
36
34
33
31
30

2
3
5
6
8
9
10
12
13
14
15
16
17
19
20
21
23
24
26
27

1
56
28
29

1A1
1A2
1A3
1A4
1A5
1A6
1A7
1A8
1A9
1A10
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8
2A9
2A10

1Y1
1Y2
1Y3
1Y4
1Y5
1Y6
1Y7
1Y8
1Y9

1Y10
2Y1
2Y2
2Y3
2Y4
2Y5
2Y6
2Y7
2Y8
2Y9

2Y10

1OE1
1OE2
2OE1
2OE2

R24 100K
R23 100K
R22 100K
R21 100K

R31

10K

R27 100K

nWE_RAM
nOE_RAM

PD[0..15]PA[0..19]

TA[0..15]

A[0..19]

nDSP_ADR

D_TRACE

nOE_BRP
nWE_BRP

BOI
TR_OP1
TR_OP0

BRP_ROM

TD[0..20]

nOE_TRAM
nWE_TRAM



5

5

4

4

3

3

2

2

1

1

D D

C C

B B

A A
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nWE_MRAM

M_RW

nM_AS

M_P25

nM_DS

nOE_MRAM

MD7

MD4

MD2

MD5

MD3

nRESET2

MD6

MD0
MD1

nWE_MRAM

MA8

MA12

MA0

MA5

MA0

MA7

MA3

MA13

MA8

MA10

MA10

MA1

MA4

MA2

MA9

MA7

nM_AS

MA2

MA6

MA1

MA11

MA11

MA4

MA15

MA6

MA9

MA5

MA14

MA3

MA2

MA4

MA1

MA12
MA13
MA14

MA5
MA6

MA11

MA9

MA0

MA7

MA3

MA10

MA8

nOE_MRAM

MD7

MD4

MD0

MD6

MD2

MD0

MD0

MD2

MD5

MD1

MD4
MD5

MD1

MD3

MD5

MD3

MD7

MD7

MD2

MD1

MD6

MD3

MD6

MD4

nRESET2

MA14
MA13
MA12

MD1
MD2

MD4

MD0

MD3

MD5
MD6
MD7

MA15

VCC
FA15

FA15

VCC

VCC

VCC

VCC

VCC

VCC

J13

USB BJACK

1
2
3
4
5

VBUS
D-
D+
AGND
SHIELD

U32

74F374

3
4
7
8
13
14
17
18

1
11

2
5
6
9

12
15
16
19

D0
D1
D2
D3
D4
D5
D6
D7

OC
CLK

Q0
Q1
Q2
Q3
Q4
Q5
Q6
Q7

R58

18R+/-1%

R60

1K

J15
1
2
3

U31

Z86C9325FSC

32

5

11

2

44

43

4

3

13

10

33

7
9
8

17

3414
3515
3616
3718
3819
4020
4121
4222

23
24
25
26
27
29
30
31

28
6

39

P34

P30

P35

XTAL2

P36

P31

P37

XTAL1

P32

AS

P33

RESET
DS

R/W
IACK

P20P00
P21P01
P22P02
P23P03
P24P04
P25P05
P26P06
P27P07

P10
P11
P12
P13
P14
P15
P16
P17

SYNC
SCLK

WAIT

Y2

7.3728 MHz

C21
10pF

+

C26
10uF

+
C23
10uF

U33

IDT7125620PZ

10
9
8
7
6
5
4
3

25
24
21
23
2

26
1

22
20
27

11
12
13
15
16
17
18
19

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9
A10
A11
A12
A13
A14

OE
CS
WE

D0
D1
D2
D3
D4
D5
D6
D7

P8

DB9F

5
9
4
8
3
7
2
6
1

C32

22pF

C22
10pF

+C25
10uF

C31

22pF

L2

.1uh

1 2

R57 1.5K

R56

18R+/-1%

C34

56pF

C33

.1uf

1 2

48MHz
Y3

C28

0.1uF

C30

22pF

L1

.47uh

1 2

+

C29

1.0uF16V

U29

MAX232

6

1
3

4
5

2

14
13
7
8

11
12
10
9

V-

C1+
C1-

C2+
C2-

V+

TX1
RX1
TX2
RX2

TD1
RD1
TD2
RD2

C27
0.01uF S1

U34

USBN9602

8
9

10
11

21

12
13
14
15

7
1

17

284

2
3

5
6

24

16

23

26
27

22

20
19

18

25

D0
D1
D2
D3

GND

D4
D5
D6
D7

ALE
CS

AGND

CLKOUTINTR

RD
WR

DRQ
DACK

MODE1

RESET

GND

XIN
XOUT

VCC

D-
D+

VOUT3.3

MODE0

U30

DS1233-15

3

1
2Vin

Gnd
/RST

R54

1K +

C24
10uF

R55

100K

U35

AM29F010J_SKT

13

12

14

11

15

10

17

9

18

8

19

7

20

6

21

5
27
26
23
25
4

28
29
3
2

1
30
32
1631

22
24

D0

A0

D1

A1

D2

A2

D3

A3

D4

A4

D5

A5

D6

A6

D7

A7
A8
A9
A10
A11
A12
A13
A14
A15
A16

NC1
NC2
VCC
GNDWE

CS
OE

MD[0..7]

MA[8..15]

nROM_MON
nOE_MRAM

nRAM_MON

nRESET2

nCS_USB
ALE

TR_INT

nWE_MRAM

nIRESET

nM_AS

M_RW
nM_DS

M_P25



5

5

4

4

3

3

2

2

1

1

D D

C C

B B

A A
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MA15

TD12

PD1

TD14

MD2
MD1

PD10

MA11

MD3

PA13

PD2

TD8

PD13

PD7

MA8

PD14

PD12

PA2

PA0

TD1

TD9

MA13

MA9

PD4

PD0

MD5

PA1

MA12

PD3

PA15

PA11
PA12

TD3

MD6

TD13

TD15

TD4

MD4

TD2

PA9

PA7

PA4
PA5

TD10

PD6

EXT_TRIG

TD0

PD15

PD11

PA6

TD5

PD8

MA14

PA14

MD0

MD7

PD9

PA3

PA8

PA10

TD11

TD6
TD7

MA10

PD5

TA1

TA8

TA15

TA11

TA14

TA9

TA7

TA0

TA12

TA5

TA2

TA13

TA10

TA4
TA3

TA6

PA16

MSEL0

VCC

nSTATUS

DATA

GND
nS/P

MSEL1

TD16
TD17
TD18
TD19
TD20

nRESET2

DCLK

DCLK

nCONFIG
CONF_DNE

nSTATUS
DATA

CONF_DNE
nCONFIG

VCC

VCC

VCC

VCC

VCC

VCC

VCC

VCC

VCC

VCC

VCC

VCCVCC

P9
1
3
5
7
9

2
4
6
8
10

R2F

10K

1
7

R3D

10K

1
5

R1D

10K

1
5

R2D

10K

1
5

R3E

10K

1
6

R2E

10K

1
6

R2G

10K

1
8

R1B

10K

1
3

R3A

10K

1
2

Z90369PLD

U1

33

5
21

56
172

9
162

146
166

98
79

41

175

163
197

13

17
16
15
14
10

8
7
6

198
199
200
202
203
204
205

152

196

164

189

178
180

182

23
117

18
170

188

118
187

181

169

195

99

177
113
194

173

179

75
74
73
72
71
70
68
67
66
65
64
63
62
61
59
58

46
45
44
40
39
38
37
36
32
31
30
29
26
25
24

47

108
176

80
81
82
83
84
85
86
88
89
90
91
92
93
94
95
97

22
186
153

206

120
121
125
126
127
128
129
130
133
134
135
136
137
141
142
143

116

124

107

154

138

161

1 2 51 52 53 54 10
3

10
4

15
7

158
207
208

144
145
149
150
151

168

112

111

110
109
101

10
0

777657

160

167

171

184
185
190
191
193

55

MSEL1

nSP
MSEL0

BRP_ROM
TR_OP0
TR_OP1
BOI

DSP_CLK
DSP_R/W

POLARITY
HSYNC

/RESET2

/RESET3

M_R/W
/M_DS
/M_AS

MD7
MD6
MD5
MD4
MD3
MD2
MD1
MD0

MA15
MA14
MA13
MA12
MA11
MA10
MA9

DSP_CLK1

32KHZ

EXTRIG

DSP_RD

DSP_SS
DSP_RUN

nCS_USB

/WE_MRAM
/OE_MRAM

6D01
6D00

6D02

6D7X
6D3X

/RAM_MON

/ROM_MON

/OE_BRP

/OTPC_EN

/WE_BRP
/OE_RAM
/WE_RAM

/DSP_ADR

NO_INT1

PD15
PD14
PD13
PD12
PD11
PD10

PD9
PD8
PD7
PD6
PD5
PD4
PD3
PD2
PD1
PD0

PA14
PA13
PA12
PA11
PA10

PA9
PA8
PA7
PA6
PA5
PA4
PA3
PA2
PA1
PA0

PA15

ALE
TR_INT

TA0
TA1
TA2
TA3
TA4
TA5
TA6
TA7
TA8
TA9

TA10
TA11
TA12
TA13
TA14
TA15

D_TRACE
nOE_TRAM
nWE_TRAM

MA8

TD0
TD1
TD2
TD3
TD4
TD5
TD6
TD7
TD8
TD9
TD10
TD11
TD12
TD13
TD14
TD15

20MHZ

nSTATUS

nCONFIG

DCLK

CONF_DNE

DATA0

NC
0

NC
1

NC
2

NC
3

NC
4

NC
5

NC
6

NC
7

NC
8

NC9
NC10
NC11

TD16
TD17
TD18
TD19
TD20

/XOE

XRW_MEM

XRW

XOE_MEM
U7_NOE
U7_DIR

RE
SE

RV
ED

11
RE

SE
RV

ED
12

RE
SE

RV
ED

13
RE

SE
RV

ED
14

nOE_BRP1

RESERVED16

nWE_BRP1

RESERVED18
RESERVED19
RESERVED20
RESERVED21
RESERVED22

PA16

R59

10K

R1F

10K

1
7

U3B

IDT74FST3125Q

5

7
6

OE

Y
A

R1C

10K

1
4

R3G

10K

1
8

R2I

10K

1
10

R5

1K

1
2

J2
1
2
3

R6

1K

1
2

U3A

IDT74FST3125Q

2

4
3

OE

Y
A

U2

EPC1441LC20

1

2

3

4

5

6

7

8
9

10

11

12

13

14

15
16

17

18
19
20

NC1

DATA

NC2

DCLK

NC3

NC4

NC5

OE
nCS

GND

NC6

nCASC

NC7

NC8

NC9
NC10

NC11

VCC
NC12
VCC

R7

1K

1
2

Y1

20.48MHZ

14

7

8

1

VCC

GND

OUT

NC

R4

100

J1
1 2

R1E

10K

1
6

R2C

10K

1
4

R1A

10K

1
2

R3H

10K

1
9

R3C

10K

1
4

R1I

10K

1
10

R1H

10K

1
9

R2H

10K

1
9

R1G

10K

1
8

R2B

10K

1
3

R3B

10K

1
3

CU16

0.1uF

CU19

0.1uF

CU17

0.1uF

CU15

0.1uF

R62

1K

1
2

CU18

0.1uF

CU22

0.1uF

CU21

0.1uF

CU26

0.1uF

CU25

0.1uF

CU24

0.1uF

CU23

0.1uF

CU20

0.1uF

R61

1K

1
2

R2A

10K

1
2

TA[0..15]

PA[0..16]

PD[0..15]

nWE_MRAM

6D7X

nOE_TRAM

nOE_RAM

D_TRACE

TR_INT

MD[0..7]

32KHZ

6D02

nOTPC_EN

NO_INT1

nOE_MRAM

DSP_SS

ALE

DSP_RD

MA[8..15] M_RW

6D3XnM_AS

nRESET2 nDSP_RUN

nWE_RAM

nRAM_MON

6D00

DSP_CLK1

6D01

nWE_BRP
nOE_BRP

nROM_MON

nCS_USB

TD[0..20]

nDSP_ADR

nM_DS

nWE_TRAM

nRESET3

TR_OP1

DSP_CLK

POLARITY

BRP_ROM

H_SYNC

TR_OP0

BOI

DSP_RW

nXOE

U7_DIR
U7_NOE
XOE_MEM
XRW_MEM
nOE_BRP1
nWE_BRP1

XRW



A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2
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MD5

MD1

MD3

MD6

MD3
MD2

MD7

MD4

MD0

MD7

MD6
MD5

MD2

MD0
MD1

MD4

IB6

IB7

32KHZ

V3B

DSP_CLK

P02

IB13

I2CMD1

LPF

DSP_SS

EA0

P10

P18

IB15

IB1

IB3

IB9

P0A

IB10

VBLANK

P01
P03

P0B

IB0
EA2

IB7

IB13

I2CMC1

PWM4
PWM5

V_SYNC P11

IB10
IB11

IB11

IB15

NO_INT

DSP_EI

P04

P0C

IB14

IB2
IB12

P00

IB8

EA1

P12

IB5
IB4

ADC5

P05

P07

P0D

PWM1

IB1

IB5

PWM3

PWM6
IR_IN

V1R

CMP_ADC0

P13

IB14

PA_CONN

nRESET3

DSP_RW

P06

P0E

P16

IB12

IB0

ROMLESS

P08

IB9

IB2

IB6

IB8
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